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COPYRIGHT & TRADEMARKS 

 

Copyright © 1998, 2011, Oracle and/or its affiliates.  All rights reserved. 

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names 

may be trademarks of their respective owners. 

 

This software and related documentation are provided under a license agreement 

containing restrictions on use and disclosure and are protected by intellectual property 

laws. Except as expressly permitted in your license agreement or allowed by law, you 

may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, 

exhibit, perform, publish or display any part, in any form, or by any means. Reverse 

engineering, disassembly, or decompilation of this software, unless required by law for 

interoperability, is prohibited. 

 

The information contained herein is subject to change without notice and is not warranted 

to be error-free. If you find any errors, please report them to us in writing. 

If this software or related documentation is delivered to the U.S. Government or anyone 

licensing it on behalf of the U.S. Government, the following notice is applicable: 

 

U.S. GOVERNMENT RIGHTS 

Programs, software, databases, and related documentation and technical data delivered to 

U.S. Government customers are “commercial computer software” or “commercial 

technical data” pursuant to the applicable Federal Acquisition Regulation and agency-

specific supplemental regulations. As such, the use, duplication, disclosure, modification, 

and adaptation shall be subject to the restrictions and license terms set forth in the 

applicable Government contract, and, to the extent applicable by the terms of the 

Government contract, the additional rights set forth in FAR 52.227-19, Commercial 

Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, 

Redwood City, CA 94065. 

 

This software is developed for general use in a variety of information management 

applications. It is not developed or intended for use in any inherently dangerous 

applications, including applications which may create a risk of personal injury. If you use 

this software in dangerous applications, then you shall be responsible to take all 

appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of 

this software. Oracle Corporation and its affiliates disclaim any liability for any damages 

caused by use of this software in dangerous applications. 

 

This software and documentation may provide access to or information on content, 

products and services from third parties. Oracle Corporation and its affiliates are not 

responsible for and expressly disclaim all warranties of any kind with respect to third 

party content, products and services. Oracle Corporation and its affiliates will not be 

responsible for any loss, costs, or damages incurred due to your access to or use of third 

party content, products or services
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BRF (University Health Hospitals) 
Web_nVision_Reports_9_1 

BRF (University Health Hospitals) Processing nVision Reports 
(Excludes Prompts) 
 

BRF (University Health Hospitals) Process Basic Reports - Web 
Method 

Procedure 

 
In this topic you will learn how to Process Basic Reports - Web Method. 

 

NOTE: Web nVision is only available in the RPT database.  
 

If you experience issues with nVision Reports, contact the PeopleSoft Financials Functional 

Support Team for assistance by opening a Help Desk Ticket. 
 

 

 

Step Action 

1. From the PeopleSoft 9.1 Launcher, select the following: 

 

PeopleSoft System:  Financials 

 

Database:  PS9 Financials Report (PS9FSRPT)  

 

Application:  PeopleSoft 
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Step Action 

2. Click the Start button. 

 

3. A warning message displays to remind you that this is not the Production database. 

 

Click the Yes button. 
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Step Action 

4. Click the Main Menu button. 

 

5. Click the Reporting Tools menu. 

 

6. Click the PS/nVision menu. 
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Step Action 

7. Click the Define Report Request menu. 
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Step Action 

8. Enter the desired information into the Business Unit field. Enter "BRFHS or 

BRFHM". 

9. Click the Search button. 
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Step Action 

10. A list of the available reports for that Business unit will display. 

 

Now, select the report you want for this particular business unit. In this example, we 

will run the Hospital Revenue and Expend Report. 

 

Click the REV_EXP link. 

 

11. This page is divided into three main sections: 

1. The Report Request Section; 

2. The Report Date Section; and 

3. The Output Options Section. 
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Step Action 

12. The Report Request Section 
 

The top section includes the Business Unit and Report Request Name, Descriptive 

Report Title, and the Layout name that is utilized by the Report Request. 

 

To the right are links that allow users to copy the report request (based on user's 

security), Transfer (navigate) to Report Books, navigate to the Process Monitor and 

navigate to the Report Manager. An additional link allows users to Share private 

report requests with other users (security based). 
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Step Action 

13. The Report Date Section 
 

Includes the “As of Reporting Date” and the “Tree As of Date”. Typically, the “As 

of Reporting Date” is either the “Business Unit Reporting Date” or the selection of 

“Specify” which allows the user to enter a specific date for the report. The “Tree as 

of Date” will typically be set to “Use As of Reporting Date”. 

 

A check box displays below the Tree As of Date line that reads, "Override Tree As 

of Date if Specified in Layout". This box will always remain checked. 
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Step Action 

14. The Output Options Section  

 

Output Type: Allows the user to choose the output type of Web, Window, File, 

Email, or Printer. For this example, the output type of Web is used. The output type 

of Window (most commonly used) will be demonstrated in the next exercise and in 

the example for the Drill feature. An example of sending a report via email will 

follow the Drill example. 

 

The Output format will always be Microsoft Excel, .xls: The other option, 

HTML, will produce reports; however, the formatting is incorrect.  
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Step Action 

15. Click the Scope and Delivery Templates link in the Output Options section. 

 

16. The options displayed on this link's subpage are determined by the Output Type 

selected on the Report Request tab. The examples in this screenshot are based on the 

output type of Web.  

 

• The Report Scope Box will contain the Scope name if one is used with the Report. 

Scopes are used to create multiple report instances based on a set of parameters. 

There are no reports that use Scope for the University Health Hospitals. 
• The Folder Name will not be used for web based report distribution within the 

repository. This option only displays if the Output Option Type is Web. 

• The Directory Name Template box will be used to identify the file location if the 

File output type is selected. The Output Type of File is not a valid option for the 

University Health Hospitals. 
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Step Action 

17. • The File Template is used to identify the file name that will appear in the Report 

Repository. This option will display when the Output Options Type is File, Email, 

or Printer. 

 

• The Content Description Template is also used to identify the file name that will 

appear in the Report Repository. This option will display when the Output Options 

Type is Web or Window.  

 

NOTE: The variables currently exist in the Windows version of nVision and will 

be carried over to the Web product. 
 

The values displayed in the screen shot use Report Variables. The %RBU%-

%RTT% (Requesting Business Unit - Report Title), the %RID% (Report ID) and the 

%SFD%-%RTT% (Scope Field Description - Report Title) are the most common 

examples. 

 

• The Security Template will not be used for Web based Report Distribution within 

the repository. 
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Step Action 

18. Most often, users will not make any changes to this subpage. 

 

Click the OK button. 

 

 

 
 

Step Action 

19. Click the Advanced Options tab. 
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Step Action 

20. Generally, you should not need to change any of the settings on this page. 

 

Click the Enter Delivery Template Options - View All link. 
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Step Action 

21. This page includes all of the entry boxes from the link on the Report Request page, 

plus a File template and an Email template.  

 

The File template box is used to name the .xls field. NOTE: This feature is not 

currently used for the University Health Hospitals. 
 

The Email box would be used only if the report output type is set to Email. 

 

Click the OK button. 
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Step Action 

22. Click the LSU Define Prompt tab. 
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Step Action 

23. This page allows the user to enter the prompt values for the reports that use run-time 

prompts. Fields that are bold are required prompt values for the report. In this 

example, the report is a basic one; not using any prompts. Thus, there are no 

required fields for entry. 

 

Click the nVision Report Request tab. 
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Step Action 

24. Click the button to the right of the Type field. 

 

25. Click the Web list item. 

 

26. NOTE: Every report must be saved before running the report. 
  

Click the Save button. 

 

27. Click the Run Report button. 
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Step Action 

28. On the Process Scheduler page, click the button to the right of the Server 

Name field. 

 

29. Click the PSNT list item. 

 

30. Click the OK button. 

 

You will be returned to the Report Request page. 
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Step Action 

31. Click the Process Monitor link. 
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Step Action 

32. Click the Refresh button until Run Status = Success and Distribution Status = 

Posted. 

 

REMINDER: Wait at least 15 seconds between each time you click the Refresh 

button. 

 

33. Click the Go back to Report Request link. 
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Step Action 

34. Click the Report Manager link. 
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Step Action 

35. The Administration tab should be the active tab. 

 

A list of reports for your userid displays. The uppermost report in the list is the most 

recent one. To open a report, click the report name link in the Description column of 

the page. 

 

NOTE: The information displaying in the Description column is the result of the 

specification in the Content Description Template box on the Report Request 

page. 
 

Click the Hospital Revenue and Expend link. 
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Step Action 

36. A new window opens and the report displays in an Excel window. 

 

Click the Maximize button in the upper right corner of the report to expand the 

spreadsheet to fill the window. 
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Step Action 

37. Some reports include Macros and you may receive a Security Warning pop-up. 

 

Click the Enable Content button. 

 

NOTE: The window may be minimized on the desktop. 
 

 

38. A Security Warning message will display. 

 

Click the Yes button. 

 

39. Click the Close button. 

 

40. Click the Don't Save button. 

 

41. This completes Process Basic Reports - Web Method. 

End of Procedure. 
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BRF (University Health Hospitals) Process Basic Reports - Window 
Method 

Procedure 

 
In this topic you will learn how to Process Basic Reports - Window Method. 

 

NOTE: The Window method is the most commonly used output for nVision reports. 

 

Step Action 

1. Click the Main Menu button. 

 

2. Click the Reporting Tools menu. 

 

3. Click the PS/nVision menu. 

 

 

 
 

Step Action 

4. Click the Define Report Request menu. 
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Step Action 

5. Enter the desired information into the Business Unit field. Enter "BRFHS or 

BRFHM". 

 

 
 

Step Action 

6. Click the Search button. 
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Step Action 

7. A list of available reports for that Business Unit is displayed. 

 

Now, select the report you want for this particular Business Unit. In this example, 

you will run the Balance Sheet Detail Report. 

 

Click the BSDETAIL link. 

 

8. This page is divided into three main sections: 

 

1. The Report Request Section; 

2. The Report Data Section; and 

3. The Output Options Section. 

9. The Report Request Section 
 

The top section includes the Business Unit and Report Request Name, the 

Descriptive Report Title, and the Layout name that is utilized by the Report Request. 

 

To the right are links that allow users to copy the report request (based on user's 

security), Transfer (navigate) to Report Books, navigate to the Process Monitor, and 

navigate to the Report Manager. An additional link allows users to Share private 

report requests with other users (security based). 
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Step Action 

10. The Report Date Section 
 

Includes the "As of Reporting Date" and the "Tree As of Date". Typically, the "As 

of Reporting Date" is either the "Business Unit Reporting Date" or the selection of 

"Specify" which allows the user to enter a specific date for the report. The "Tree As 

of Date" will typically be set to "Use As of Reporting Date". 

 

A checkbox displays below the "Tree As of Date" line that reads: "Override Tree As 

of Date if Specified in Layout". 

 

 
 

Step Action 

11. The Output Options Section 
 

Output Type: Allows the user to choose the output type of Web, Window, File, 

Email, and Printer. For this example, the type of Window will be selected. 

 

The Output format should ALWAYS be Microsoft Excel, .xls. The other option, 

HTML, will produce reports however, the formatting is incorrect. 
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Step Action 

12. Click the button to the right of the Type field. 

 

13. Click the Window list item. 

 

14. No other changes are needed on the page with the Output Options Type set to 

Window. 

 

Click the Save button. 

 

15. Click the Run Report button. 
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Step Action 

16. Click the button to the right of the Server Name field. 

 

17. Click the PSNT list item. 

 

18. Click the OK button. 

 

19. As the report begins to run, a pop-up window displays. It will display the status of 

the report: Queued, Processing, Success, Error, etc. 
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Step Action 

20. When the report processes to "Success", the pop-up window enlarges and a new 

Excel window displays. Sometimes, the report that opens will not be maximized. 
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Step Action 

21. Click the Maximize button. 

 

22. You may print the report or perform any nVision drills or Excel functions on the 

spreadsheet as desired. 

23. Many nVision reports include Macros to perform tasks within the spreadsheet. On 

these reports, a Security Warning will display at the top of the spreadsheet indicating 

that the Macros are disabled. 

 

If the message appears, click the Enable Content button to enable Macros. 

 

24. A pop-up Security Warning message displays. 

 

Click the Yes button. 

 

NOTE: There is a method to enable all of the macros within Excel for your 

computer. The instructions to perform this task are included in the Appendix to 

this guide. 

 

25. After enabling the Macro content and pressing the Yes button, you are returned to 

the spreadsheet. The Security Warning message has disappeared and the Macros 

included in this file are enabled. 
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Step Action 

26. Notice the grey taskbar at the bottom of the screen. To the right of the Start button, 

there are 2 Internet Explorer icons for PeopleSoft and an Excel icon. The Excel icon 

is active. 

 

To navigate back to the report request in PeopleSoft from Excel, simply click the 

Define Report Request icon.  

27. The second Internet Explorer icon, nVision-Report - NVSRUN...is for the 

processing window that was opened while running the report. This is no longer 

needed and should be closed. 

 

Right-click the nVision-Report - NVSRUN button. 
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Step Action 

28. Click the Close Window list item. 

 

29. The processing window closes, leaving only the Report Request window available in 

Internet Explorer. 

 

Click the Define Report Request button to navigate back to the Report Request 

page. 

 

30. Click the Excel button in the taskbar to navigate back to the Excel spreadsheet. 
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Step Action 

31. Click the Office button at the top left of the Excel window to close the window and 

exit Excel. 

 

32. Click the Exit Excel button. 

 

33. Click the No button. 

 

34. This completes Process Basic Reports - Window Method. 

End of Procedure. 

BRF (University Health Hospitals) Enable DrillDown Feature 
(Optional) 
DrillDown is a feature that allows users to get more information on data contained in the report. 

Before performing the very first drill on any report, the drilldown (Drill to PIA) feature must be 

enabled. Once enabled, the drill feature will be available any time you run a report with nVision. 

  

NOTE: This feature should be enabled at the PSDesktop level.  If the feature is not available, 

follow these steps to enable drilldown. 

Procedure 
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In this topic you will learn how to Enable DrillDown Feature. 

 

Step Action 

1. Click the Main Menu button. 

 

2. Click the Reporting Tools menu. 

 

 

 
 

Step Action 

3. Click the Report Manager list item. 
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Step Action 

4. Select a report and click the appropriate Description link. 

 

In this example the Balance Sheet Detail report is used. 

 

5. Click the Maximize button. 

 

6. If the Add-Ins menu is not available to you, then the DrillDown feature must be 

enabled. Once enabled, an Add-Ins option will be added next to the View option on 

your ribbon. 

  

Click the Office button. 
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Step Action 

7. Click the Excel Options button. 

 

8. Click the Add-Ins link. 

 

9. Click the DrillToPIA list item. 
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Step Action 

10. Click the Go button to the left of the Manage field. 

 

11. A small pop-up box displays. 

 

Click the DrillToPIA option. 
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Step Action 

12. Click the OK button. 

 

13. You are returned to your spreadsheet. DrillDown is enabled and a new menu option, 

Add-Ins, now displays on your ribbon. 

14. This completes Enable Drilldown Feature. 

End of Procedure. 

BRF (University Health Hospitals) Perform DrillDown 
DrillDown allows users to gather additional information on the data contained in a report 

produced by nVision. In essence, users get a "peek under the hood" to see what information 

comprises the results displayed in the report. 

  

DrillDown 

 Must be performed on cells that are at the intersection of a column and a row; 

 May only be performed on cells that contain a number, not a formula; 

 May perform additional drilldown on drilldown results; and 

 Budget data is not presently drillable. 

While reviewing the results of a report, you determine that you would like to get additional 

information; perhaps look at the individual period totals for an account or the Accounts Payable 

Detail for an account. DrillDown is the feature utilized to get this additional information. 
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Procedure 

 
In this topic you will learn how to Perform DrillDown. 

 
 

Step Action 

1. While navigating through the spreadsheet, it is recommended that users "Freeze 

Panes" so that the row and column headers remain visible. 

 

Click the cell located directly below the Current Balance column header. 

2. Click the View tab at the top of the Excel screen. 

 

3. Click the Freeze Panes option. 
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Step Action 

4. Click the Freeze Panes list item. 

 

5. In this example, you will drill on the Inv-Warehouse row and the Current Balance 

column; in the Account Assets Section of the report. 

 

Click the Down button of the scrollbar. 

 

6. Click the Inv-Warehouse row cell in the Current Balance column. 
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Step Action 

7. Click the Add-Ins tab at the top of the screen. 

 

8. Click the nVisionDrill option on the left of the Excel screen. 
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Step Action 

9. Click the Drill list item. 
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Step Action 

10. A new PeopleSoft (Internet Explorer) tab opens. This tab contains the various drills 

that are available for use. Press the yellow Run DrillDown button to the right of the 

desired drill. In this example, the Breakdown by Account and Department drill is 

selected. 

 

NOTE: The Type: selection box at the top of the page displays Window so that the 

drill runs to the output option of Window. For drills, this is the default. The other 

option is Web, which would run the drill report and post it to the report repository. 
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Step Action 

11. Click the Run DrillDown button for the Breakdown by Account and Dept option. 

 

12. When a report is run with the output type of Window, the nVision drill menu is 

replaced by the status window. Once completed, the status of "Success" displays in 

the window. At the same time, a new Excel spreadsheet window is created that will 

display the drill results. 

13. The Drill opens in a new window. 

 

Press the DR_xxxxx_xxxx window at the bottom of the page if it does not maximize 

automatically. Or, if the window opens but the files are not full screen, you may 

press the maximize icon to enlarge the file on the screen. 

14. Click the Maximize button. 

 

NOTE: Once the drill window is maximized, you may print the spreadsheet, 

perform any Excel functions, or even perform an additional drill. 

 

15. Once you are finished with this drill file, you may close it by pressing the lower 

most X at the top right of the page. 

 

Click the Close Window button. 
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Step Action 

16. Click the No button. 

 

17. You are returned to the original nVision report file where you may perform 

additional drills if desired. 
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Step Action 

18. In this example, you will drill on the Prepaid Expense-Insurance row cell in the 

Current Balance column. The drill option you will use is BRF Hospitals Journal 

Drill. 

 

Click the Down button of the scrollbar. 

 

19. Click the Prepaid Expense-Insurance cell. 

 

20. The Add-Ins menu is already displayed, so there is no need to select it. 

 

Click the nVisionDrill menu. 

 

21. Click the Drill list item. 
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Step Action 

22. Click the Run DrillDown button for the BRF Hospitals Journal Drill option. 

 

23. When a report is run in the output type of Window, the nVision drill menu is 

replaced by the status window. Once completed, the status of "Success" displays in 

the window. At the same time, a new Excel window is created that will display the 

drill results.  

24. The Drill opens in a new window. 

 

Press the DR_xxxxx_xxxx window at the bottom of the page if it does not display 

automatically. If the window opens but is not maximized, press the maximize button 

to enlarge the report. 

 

Click the Maximize button. 
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Step Action 

25. In many instances, users will want to filter the drill results to limit the data by a 

specific department, fund, period, or other criterion. Autofilter is used to perform 

this task. 

  

Click the Data menu. 
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Step Action 

26. Click the Filter menu. 

 

 



Training Guide 

 
BRF (University Health Hospitals) 
Web_nVision_Reports_9_1 
 

 Page 52 

 
 

Step Action 

27. Each column heading is now populated with a drop-down arrow. 

 

Click the button to the right of the Journal ID field. 

 

28. Click the Select All option. 

 

29. Click the GAC1013054 option. 
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Step Action 

30. Click the OK button. 

 

31. The spreadsheet now displays only the results for that Journal ID. To return to the 

full listing, press the filter arrow next to Journal ID and choose the checkbox next to 

Select All. 

32. This completes Perform DrillDown. 

End of Procedure. 

BRF (University Health Hospitals) Process Reports - Output type 
PRINTER 

Procedure 

 
In this topic you will learn how to Process Reports - Output type PRINTER. 
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Step Action 

1. Navigate to the Report Request search page as follows: 

 

Main Menu > Reporting Tools > PS/nVision > Define Report Request 

2. Enter the desired information into the Business Unit field. Enter "BRFHS or 

BRFHM". 

3. Click the Search button. 
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Step Action 

4. Click the TBDETAIL link. 

 

5. Click the button to the right of the Type field. 

 

6. Click the Printer list item. 
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Step Action 

7. Click the Save button. 

 

8. Click the Run Report button. 

 

9. Click the button to the right of the Server Name field. 

 

10. Click the PSNT list item. 

 

11. On the Process Scheduler Request page, you must select the Type as Printer. 

 

Click the button to the right of the Type field. 

 

12. Click the Printer list item. 

 

13. Once the Type is changed to "Printer", the Format option changes to "XLS" and a 

Output Destination field displays.  
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Step Action 

14. In the Output Destination box, enter the network printer to which the report will 

be sent. If you are unsure of the network printer to which you should send the 

report, contact your local PC supporter. 
 

 

For training purposes only, enter the desired information into the Output 

Destination field. Enter "\\lafprnsrv\LANIER". 

15. You would then click the OK button to return to the Report Request page. The 

report will process and then be sent to the selected printer. 

 

For training purposes only, click the Cancel button. 

 

16. This completes Process Reports - Output type PRINTER. 

End of Procedure. 

BRF (University Health Hospitals) Process Reports - Output type E-
MAIL 
nVision Reports may also be emailed directly to other PeopleSoft users. The report request is 

used to define the user to whom the report will be sent. When using this feature, you will not have 

the opportunity to review the report prior to sending it via email. 

Procedure 
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In this topic you will learn how to Process Reports - Output type E-MAIL. 

 
 

Step Action 

1. Navigate to the Report Request search page as follow: 

 

Main Menu > Reporting Tools > PS/nVision > Define Report Request 

2. Enter the desired information into the Business Unit field. Enter "BRFHS or 

BRFHM". 

3. Click the Search button. 
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Step Action 

4. Click the TBPERIOD link. 

 

5. Click the button to the right of the Type field. 

 

6. Click the Email list item. 
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Step Action 

7. Click the Scope and Delivery Templates link. 

 

8. On the nVision Email Output page, enter the recipient's email address in the Email 

Template field. Multiple user email addresses can be entered, but must be separated 

by a comma (e.g. xxxxxx@lsuhsc.edu, xxxxxx@lsuhsc.edu). 

 

Enter the desired information into the Email Template field. Enter "Recipient's 

Email Address". 
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Step Action 

9. Click the OK button. 

 

10. Click the Save button. 

 

11. Click the Run Report button. 

 

12. Click the button to the right of the Server Name field. 

 

13. Click the PSNT list item. 

 

14. Click the OK button. 

 

15. Click the Process Monitor link. 
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Step Action 

16. Click the Refresh button every 15 - 20 seconds until the Distribution Status is 

"Posted".  

 

Click the Refresh button. 
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Step Action 

17. Once the Distribution Status = Posted, the system will generate and send an email to 

the listed email account with the report attached.  

 

NOTE: The email will be sent from PS9FSPRSCH@lsuhsc.edu. 
 

Click the Outlook button. 
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Step Action 

18. Double-click the TBPERIOD.xls attachment to view the report. 

 

 



 

Training Guide 
BRF (University Health Hospitals) 

Web_nVision_Reports_9_1 

 

 Page 65 

 

Step Action 

19. A new window is opened and the report displays. Once the report is open, you may 

perform any drill or Excel function as desired. 

 

NOTE: You may receive a security message if the report is not from a trusted 

source. 
 

Click the Close button. 

 

20. This completes Process Reports - Output type E-MAIL. 

End of Procedure. 

BRF (University Health Hospitals) Process Reports - Output type E-
MAIL (User may enter text in the body of email) 

Procedure 

 
In this topic you will learn how to Process Reports - Output type E-MAIL (User may enter 

text in the body of email). 

 

NOTE: This topic teaches the user an alternate method for distributing reports via email. This 

method allows the sender to enter text into the body of the email. 
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Step Action 

1. For this exercise, the same Report Request as used in the last lesson will be utilized. 

Click the Go back to Report Request link. 

 

2. Click the button to the right of the Type field. 

 

3. Click the Web list item. 

 

4. Click the Save button. 

 

 

 
 

Step Action 

5. Click the Run Report button. 

 

6. Click the button to the right of the Server Name field. 

 

7. Click the PSNT list item. 
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Step Action 

8. On the Process Scheduler Request page, the Type must be changed from "Default" 

to "Email". 

 

Click the button to the right of the Type field. 

 

9. Click the Email list item. 

 

 

 
 

Step Action 

10. The Format will automatically change to XLS, and a new link called Distribution 

displays when the Type Email is selected. 

 

Click the Distribution link. 

 

11. Enter the desired information into the Email Subject field. Enter "TBPeriod 

Training Example". 

12. Enter the desired information into the Message Text field. Enter "Please review.". 



Training Guide 

 
BRF (University Health Hospitals) 
Web_nVision_Reports_9_1 
 

 Page 68 

Step Action 

13. Enter the desired information into the field. Enter "xxxxx@lsuhsc.edu, 

xxxxxx@lsuhsc.edu". 

 

 
 

Step Action 

14. NOTE: The email feature is a great tool. However, it does not allow the sender to 

"preview" the report output before sending it to the recipient. 
 

Click the OK button. 

 

15. Click the OK button. 

 

16. Click the Process Monitor link. 

 

17. Click the Refresh button every 15 - 20 seconds until the Distribution Status is 

"Posted". 

 

Click the Refresh button. 
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Step Action 

18. The report is processed and the system delivers an email to the specified users. 

 

Click the Outlook button. 
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Step Action 

19. Double-click the TBPERIOD.xls attachment. 

 

20. Click the Maximize button. 

 

21. Click the Close button. 
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Step Action 

22. Click the No button. 

 

23. This completes Process Reports - Output type E-MAIL (User may enter text in the 

body of email). 

End of Procedure. 

 

BRF (University Health Hospitals) Processing nVision Report 
(Includes Prompts) 

BRF (University Health Hospitals) Process Prompt Reports 

Procedure 

 
In this topic you will learn how to Process Prompt Reports. 

 

Step Action 

1. Click the Main Menu button. 
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Step Action 

2. Click the Reporting Tools menu. 

 

3. Click the PS/nVision menu. 

 

 

 
 

Step Action 

4. Click the Define Report Request menu. 

 

5. Enter the desired information into the Business Unit field. Enter "BRFHS or 

BRFHM". 

6. The Report Requests for reports that include prompts all begin with the letter 

"W". To choose a report request from the available list, enter a "W" in the Report 

ID field. 

 

Enter the desired information into the Report ID field. Enter "W". 

7. Click the Search button. 
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Step Action 

8. A list of available Report Requests for the specified Business Unit displays. Scroll 

through the list and select the report request called WRVEXPRM. 

 

Click the WRVEXPRM link. 

 

9. Click the LSU Define Prompt tab. 
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Step Action 

10. This page is used to enter the prompt values desired to run the report. Each of the 

fields that appear in bold print are required for this particular report. The fields that 

appear in grey are not utilized in this case. 
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Step Action 

11. The Business Unit is required for every report as it defaults in from the Report 

Request. The Business Unit may be overwritten on the LSU Define Prompts tab to 

request different data for a different Business Unit.  
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Step Action 

12. When required in a Report Request, the chartfield values may accept wildcards or 

partial wildcards. The date fields, when required, must be entered in full. 

13. In this example, only the Business Unit, Report ID and DEPTID are in bold text, 

thus these are the only fields requiring data. No changes are needed to the Business 

Unit. 

 

Enter the desired information into the DEPTID field. Enter "2036380". 

14. Click the Save button. 

 

15. Click the nVision Report Request tab. 
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Step Action 

16. NOTE: The Output Type is set to Window. 
 

Click the Run Report button. 

 

17. Click the button to the right of the Server Name field. 

 

18. Click the PSNT list item. 

 

19. Click the OK button. 

 

NOTE: After clicking the OK button and returning to the Report Request page, 

the nVision Processing Window will display. 

 

 



Training Guide 

 
BRF (University Health Hospitals) 
Web_nVision_Reports_9_1 
 

 Page 78 

 
 

Step Action 

20. Once the report has processed to the Success status, the Excel file opens. 

 

Click the Maximize button. 
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Step Action 

21. If the columns do not display all of the numbers correctly, you may adjust the 

column width.  

 

Highlight all columns affected by clicking on the column letter in this example, 

columns F, G, H, and I. 
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Step Action 

22. Hover the mouse at the outer end of column I. Drag the column border out until the 

columns are wider and the #### are replaced by the dollar amounts. 

 

23. You may print, save or perform any desired drilldowns. 

 

Click the Close button. 

 

24. Click the No button. 

 

25. Click the Close button. 

 

26. This completes Process Prompt Reports. 

End of Procedure. 

 

BRF (University Health Hospitals) Appendix 

BRF (University Health Hospitals) Procedure for Enabling Macros 

Procedure 
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In this topic you will learn the Procedure for Enabling Macros. 

 

Step Action 

1. Users may choose to enable all macros for Excel/nVision thus allowing all of the 

custom macros in the nVision reports to run as desired. The user must enable all 

macros through the Trust Center in Excel Options. Once selected, this setting is 

retained from PSDesktop session to session. If a user chooses not to enable all 

macros, the user would need to enable macros for each file containing macros. Both 

methods are detailed in the following steps. 

 

 
 

Step Action 

2. Enabling All Macros 
 

Click the Office button. 
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Step Action 

3. Click the Excel Options button. 

 

4. Click the Trust Center menu. 
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Step Action 

5. Click the Trust Center Settings button. 

 

6. Click the Macros Settings menu. 

 

7. Click the Enable all macros (not recommended; potentially dangerous code can 

run) option. 
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Step Action 

8. Click the OK button. 
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Step Action 

9. Click the OK button on the Trust Center page. 

 

10. The settings will now be retained from session to session. 

11. This completes Procedure for Enabling Macros. 

End of Procedure. 

 

 

 

 


